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Overview 
 

HomeWorks QS is a system capable of integrating with other equipment in many ways.  In most 
instances this integration can be accomplished using TCP/IP and an Ethernet network, however, it is 

sometimes necessary to integrate with legacy devices utilizing RS-232 serial connections.  HomeWorks 
QS does not include an on-board RS-232 port, but a simple inexpensive device can be added that will 

convert Ethernet to RS-232 to accomplish this integration.  This application note describes how to set up 

and configure integration with the HomeWorks QS system using both Ethernet and RS-232.  There are 
four integration scenarios that will be described in this document. 

 
 
 Scenario 1:   Integration with Ethernet Connected Devices Using 

the Lutron Integration Protocol 
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 Scenario 2:   Integration with Ethernet Connected Devices Using 
Custom Integration Commands  
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 Scenario 3:   Integration with RS-232 Devices Using the Lutron 
Integration Protocol 
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 Scenario 4:   Integration with RS-232 Devices Using Custom 
Integration Commands 
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 Appendix: - Digi One SP / B&B Electronics ES1A RS-232 Pinout  
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Scenario 1:  Integration with Ethernet Connected Devices 
Using the Lutron Integration Protocol 

 
Overview: 
 
In this scenario, integration between HWQS and 3rd-party devices is accomplished using an Ethernet 

connection and the Lutron Integration Protocol, which is well documented and freely available.  This is 
the most common type of integration with a HWQS system.  Many 3rd-party systems and devices have 

fully functional two-way integration drivers for HWQS that utilize the Lutron Integration Protocol and 

allow for simplified bi-directional integration.  The 3rd-party device must open and maintain a Telnet 
session with the HWQS system. 

 

Equipment Required: 
 
All versions of HWQS software can be used in this scenario.  No additional equipment is required when 

integrating with Ethernet connected devices using the Lutron Integration Protocol.   
 

Set Up Steps:  
 
1. Configure integration IDs and Telnet logins in the HWQS software.  This is accomplished by 

clicking on “configure integration” in the Tools drop-down menu.   

 

 
 

A separate Telnet login must be created for each device. If the homeowner prefers to have the 

ability to edit some aspects of their system programming through the Lutron Home Control+ 
mobile app, make sure that the “Allow Homeowner Editing” box is checked. Click on “Add Telnet 

Login” in the lower left corner of the “Configure Integration” window to add another telnet login. 
 

 
 

 
 

Be sure to enable integration IDs for all the devices, shades, areas, zones, timeclocks, and HVAC 
controls that you desire to integrate with.  Everything should be checked by default.  If any of 

these are not checked, they will not be available through integration.  These settings are also 
used by the Lutron Home Control+ mobile apps, so do not uncheck anything you would like to 

access from these apps. 
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2. Configure the Ethernet connected devices to establish a Telnet session with the HWQS processor.  

This is done using the 3rd-party device or associated software.  Consult that product’s 
documentation for details. 

 

3. Configure the 3rd-party devices and systems to utilize the Lutron Integration Protocol with the 
appropriate integration IDs.  Many 3rd-party devices have drivers for Lutron systems and devices 

that will allow easy integration between the two.  In other cases, you may be required to 
configure the 3rd-party device to send the appropriate command.  Consult the Lutron Integration 

Protocol, available within the HWQS software for details.  The Integration ID is listed beside each 
device you have enabled for integration or can be found in the Integration Report, available in 

the Report Center. 

 

 
 

4. Connect all devices to the same Ethernet network and subnet (refer to the HWQS Networking 

Guide for details).  The devices must be able to communicate over the Ethernet network for the 
integration to function properly. 
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Scenario 2:  Integration with Ethernet Connected Devices 
Using Custom Integration Commands  

 

Overview: 
 
In this scenario, integration between HWQS and 3rd-party devices is accomplished using an Ethernet 

connection and the 3rd-party device’s communication commands.  Common examples include spa/pool 
controllers, A/V components, and thermostats.  The HWQS system will open and maintain the Telnet 

session or TCP connection with the 3rd-party device. Communication between the 3rd party system and 
the HWQS system is bi-directional. A driver must be created within the HWQS software to allow the 

HWQS system to be able to send and receive the 3rd party commands. 

 

Equipment Required: 
 
HWQS software version 2.0 or later must be used in this scenario.  Prior to the 6.x version of the 

software, only commands sent to the 3rd party device were supported. Bi-directional communication 
support is available in software versions 6.x and newer. No additional equipment is required when 

integrating with Ethernet connected devices using custom integration commands.   
 

Set Up Steps:  
 
1. Add a “Control 3rd Party” device to your project on the “design” tab under the “define equipment” 

task.  A “Control 3rd Party” device must be added for each device you intend to integrate with 

using custom integration commands.  If the device is not shown in your toolbox, you may need 
to edit your toolbox to add the device. 

 

 
 

 
 
2. The Ethernet integration can be accomplished in one of two ways:  using Telnet (the HWQS 

system will open and maintain a Telnet session with the 3rd-party device) or by sending raw TCP 
data to a specified port on the 3rd-party device.   

 

If using Telnet, the IP address of the 3rd-party device, Telnet port (default is 23), and the Telnet 
username and password must be entered.  These settings must match the 3rd-party device. 
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If sending raw TCP data, the username and password fields must be left blank, however, the IP 

address of the 3rd-party device must be entered in the address field and the TCP port to send the 

data to must be entered in the Port field. 

 

 
 
3. “Edit Command Sets” to create a custom command set for the 3rd-party device.  This screen can 

be opened by clicking the “Edit Command Sets” link in the “Equipment Locations” box, or by 

going to the “Tools” menu and choosing “Configure Integration”.  Once in this window, you can 
“Add Command Sets” and “Add Commands” to existing command sets.  The data can be entered 

in ASCII text or Hex values.  You also have the option of appending an RS-232 terminator to 
each command, if required by the 3rd-party device.  Telnet typically requires <CR> <LF> 

terminators, but this can vary based on the device used. 

 
Commands are assigned a Nickname to identify the command when programming. In versions 

6.0 and later, communication direction indicates whether the command is To, From, or both To 
and From. The actual command is then typed into the Command field. 

 

 
 

4. Assign this command set to the 3rd-party device in the project.  This can be chosen from the 

drop-down box on the device. If using software versions 7.x and newer, proceed to Step 5. If 
using a prior version of software, skip ahead to step 6. 
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5. FOR SOFTWARE VERSION 7.x AND NEWER ONLY – 3rd Party Controls need to be assigned to a 

specific processor in the database. Go to “Link Assignment” on the Design tab. Click on the 

appropriate Ethernet link to assign the 3rd Party Control. On the right-hand side of the screen, 
find the 3rd Party Control that is to be assigned and check the box to assign it to 1 of the 5 

available Ethernet Connections for the specific processor. NOTE: Processor 1 has two of its 
Connections occupied, by default, for the Remote Access feature of Home Control+. It is possible 

to regain these two Connections by disabling the Home Control+ Remote Access feature. To 
disable this feature, check the “Disable Home Control+ Remote Access” option. 

 

 
 

6. Program keypads, timeclocks, etc. to send commands to the 3rd-party device.  This is done on 
the “program” tab.  Choose “Control 3rd Party” from the “Assignable Items” list to view the 

devices in your project.  The “Settings” drop down will display the integration commands that 
were configured for that device.   
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7. If you would like LED feedback on the buttons, you should create a state variable and assign it to 

the button in addition to assigning the custom output strings.   
 

In versions 6.0 and later, the variable state should then also be assigned to the incoming 3rd 
party command. Programming the incoming 3rd party commands is similar to programming 

keypads. You can find the 3rd Party Controls in the Device Location menu and select the 3rd Party 

Control as if you were selecting a keypad, in an area, to program.  For example, when controlling 
a media playback device with commands to Play, Pause, and Stop, create a state variable with 

these same states and assign the variable states to the button that sends the corresponding 
command to the media playback device.  Similarly, the variable will then need to be assigned to 

the appropriate incoming 3rd Party command. Using scene LED logic on the button will ensure 
that the LED will be lit only when that state is true. 
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8. Connect all devices to the same Ethernet network and subnet (refer to the HWQS Networking 
Guide for details).  The devices must be able to communicate over the Ethernet network for the 

integration to function properly. 
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Scenario 3:  Integration with RS-232 Devices Using the 
Lutron Integration Protocol 

 

Overview: 
 
In this scenario, integration between HWQS and 3rd-party devices is accomplished using an RS-232 serial 

connection and the Lutron Integration Protocol, which is well documented and freely available.  Many 3rd-
party systems and devices have fully functional two-way integration drivers for HWQS that utilize the 

Lutron Integration Protocol and allow for simplified bi-directional integration.  An Ethernet to RS-232 
converter will be required, since the HWQS system has Ethernet connections and the 3rd-party device has 

only an RS-232 port.  The converter device must open and maintain a Telnet session with the HWQS 

system, which will then allow the Lutron Integration Protocol data to pass through to the RS-232 port.  
This scenario is identical to Scenario 1 in this document with the exception that the Ethernet to RS-232 

converter device is used between the HWQS system and the 3rd-party device. 
 

Equipment Required: 
 
All versions of HWQS software will work with this scenario.  An Ethernet to RS-232 converter device is 
required to communicate with RS-232 devices from a HWQS system.  There are many devices with these 

capabilities, however, two such devices that Lutron has had success with are the following: 

 
Digi One SP 

www.digi.com 
 

 
B & B Electronics ES1A 

www.bb-elec.com 
 

 

 

 

Set Up Steps:  
 
1. Connect the Ethernet port on the Ethernet to RS-232 converter device to the same Ethernet 

network as the HWQS system and your computer.  A standard Ethernet patch cable can be used. 
 

2. Open the web-based configuration and management portal for the device.  This can be 

accomplished by using the setup utility included with the device, or by using the web-based 
configuration and management portal.  The steps contained in this document are for the Digi 

One SP device using the web-based setup, but are similar to those for the B & B Electronics ES1A 
device.  The configuration and management portal is accessed by pointing your internet browser 

http://www.digi.com/
http://www.bb-elec.com/
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to the IP address of the device.  The default username is “root” and the default password is 

“dbps”.  The home screen is shown below. 
 

 
 

3. Configure the network settings on the Ethernet to RS-232 converter device by clicking on the 

“Network” option on the left side.  It is recommended to use a static IP address.  This address 
should be outside the DHCP range of the router.  The device must be on the same network and 

subnet as the HWQS processor.  Be sure to Apply the settings.  The device may need to reboot 
for the settings to take effect. 

 

 
 

4. Configure the serial port port profile on the converter device by clicking on the “Serial Port” 

option on the left side and then selecting “Port Profile” at the top.  Choose the “TCP Sockets” 
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port profile.  Under “TCP Client”, check the box to “Automatically establish TCP connections”.  

Enter the IP address of the HWQS processor in the “Connect To:” field.  Choose “Telnet” in the 
“Service:” field.  Enter “23” in the “TCP Port Number:” field.  Be sure to Apply the settings.  The 

image below contains the appropriate settings, however, you must replace the displayed IP 
address with the IP address of your HWQS processor. 
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5. Configure the serial port parameters by clicking the “Serial Port” option on the left side and then 

selecting “Basic Serial Settings”.  Set the baud rate, data bits, parity, stop bits, and flow control.  
These are determined by the 3rd-party device that will be connected to the RS-232 port on the 

device, and must match. 

 

 
 

6. Refer to Scenario 1 in this document to set up the HWQS system to use the Lutron Integration 
Protocol.  From the HWQS system perspective, this scenario is identical to Scenario 1, as the 

Ethernet to RS-232 conversion occurs outside the HWQS system. 
 

7. Connect an RS-232 cable between the 3rd-party device and the converter.  Depending on the 
configuration of the 3rd-party device, you may require a null-modem cable and/or gender 

adapters.  The Ethernet to RS-232 converter devices in this document are DTE (Data Terminal 

Equipment) devices.  Refer to Appendix A at the end of this document for an RS-232 pinout 
diagram of the converter. 

 
8. The Ethernet to RS-232 converter device will automatically open the Telnet session with the 

HWQS processor, however, the 3rd-party device must send the Telnet username/password via 

RS-232 when prompted.  After the login occurs, the 3rd-party device can then utilize the Lutron 
Integration Protocol, as if the device was connected via Ethernet. 
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Scenario 4:  Integration with RS-232 Devices Using 
Custom Integration Commands 

 

Overview: 
 
In this scenario, integration between HWQS and 3rd-party devices is accomplished using an RS-232 

connection and the 3rd-party device’s communication commands.  This type of integration is commonly 
used when the 3rd-party device is capable of being controlled, however the HWQS system will not receive 

any feedback from the device.  Common examples include spa/pool controllers, A/V components, and 
thermostats. An Ethernet to RS-232 converter will be required, since the HWQS system has Ethernet 

connections and the 3rd-party device has only an RS-232 port.  The HWQS processor will open and 

maintain a TCP connection with the converter device, which will then allow the custom command strings 
to pass through to the RS-232 port.  This scenario is identical to Scenario 2 in this document with the 

exception that the Ethernet to RS-232 converter device is used between the HWQS system and the 3rd-
party device. 

 
Equipment Required: 
 
HWQS software version 2.0 or later must be used in this scenario.  An Ethernet to RS-232 converter 

device is required to communicate with RS-232 devices from a HWQS system.  There are many devices 

with these capabilities, however, two such devices that Lutron has had success with are the following: 

 
Digi One SP 

www.digi.com 
 

 
B & B Electronics ES1A 

www.bb-elec.com 
 

 

 

 

Set Up Steps:  
 
1. Connect the Ethernet port on the Ethernet to RS-232 converter device to the same Ethernet 

network as the HWQS system and your computer.  A standard Ethernet patch cable can be used. 

 

2. Open the web-based configuration and management portal for the device.  This can be 
accomplished by using the setup utility included with the device, or by using the web-based 

configuration and management portal.  The steps contained in this document are for the Digi 
One SP device using the web-based setup, but are similar to those for the B & B Electronics ES1A 

device.  The configuration and management portal is accessed by pointing your internet browser 

http://www.digi.com/
http://www.bb-elec.com/
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to the IP address of the device.  The default username is “root” and the default password is 

“dbps”.  The home screen is shown below. 
 

 
 

3. Configure the network settings on the Ethernet to RS-232 converter device by clicking on the 
“Network” option on the left side.  It is recommended to use a static IP address.  This address 

should be outside the DHCP range of the router.  The device must be on the same network and 

subnet as the HWQS processor.  Be sure to Apply the settings.  The device may need to reboot 
for the settings to take effect. 
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4. Configure the Advanced Network Settings on the Ethernet to RS-232 converter device by clicking 

on the “Network option on the left side and then clicking on “Advanced Network Settings”.  The 
settings must be set to the following: 

 
TCP Time-To-Live:  30 hops 

IP Time-To-Live:  60 hops 

Probe Interval:   10 secs 
Probe Count:   5 

Retransmission Timeout: 30 secs 
   

  Enable TCP Keepalive  (checked) 
  Idle Timeout:   1 min 

  

The settings are shown below.  Be sure to Apply the settings at the bottom of the page when done.  
These settings are important because they allow the HWQS processor to maintain the connection with 

the converter device and quickly re-establish the connection if it is lost. 
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5. Configure the serial port profile on the converter device by clicking on the “Serial Port” option on 

the left side and then selecting “Port Profile” at the top.  Choose the “TCP Sockets” port profile.  
Make note of the “Raw TCP Port” number (2101) listed under the “TCP Server”.  This is the port 

you will program the HWQS software to send the 3rd-party device commands to.  Ensure the box 
is unchecked to “Automatically establish TCP connections”.  Be sure to Apply the settings.  The 

image below contains the appropriate settings. 

 

 
 

 

 

 

 

 

 

 

 

 
 

 



       Integration with Ethernet and RS-232 Devices Page 18 
 

6. Configure the serial port parameters by clicking the “Serial Port” option on the left side and then 

selecting “Basic Serial Settings”.  Set the baud rate, data bits, parity, stop bits, and flow control.  
These are determined by the 3rd-party device that will be connected to the RS-232 port on the 

device, and must match. 
 

 
 

7. Refer to Scenario 2 in this document to set up the HWQS system to use custom integration 
commands to communicate with a 3rd-party device.  For the Address of the 3rd-party device in the 

HWQS software, use the IP address of the converter device set in step 3 and enter that IP 

address in the Address field. Enter the Raw TCP port number from step 5 in the Port Number 
field.  Leave the Username and Password fields blank.  From the HWQS system perspective, this 

scenario is identical to Scenario 2, as the Ethernet to RS-232 conversion occurs outside the 
HWQS system. 

 

 
 

8. Connect an RS-232 cable between the 3rd-party device and the converter.  Depending on the 
configuration of the 3rd-party device, you may require a null-modem cable and/or gender 

adapters.  The Ethernet to RS-232 converter devices in this document are DTE (Data Terminal 
Equipment) devices.  Refer to the Appendix at the end of this document for an RS-232 pinout 

diagram of the converter. 
 

9. The HWQS system will send the command strings to the Ethernet to RS-232 converter device on 

the specified port, which will then be passed out the RS-232 port to the 3rd-party device.  No 
login/password is required. 

  



       Integration with Ethernet and RS-232 Devices Page 19 
 

Appendix 
 

Digi One SP / B&B Electronics ES1A RS-232 Pinout 

 

 


